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ADVANCED COMPUTER TECHNOLOGY WINDOWS XP LISTENING & GUIDE & ACTIVITIES
Match words to definitions
1. ______Input

2. ______Processing

3. ______Output

4. ______Auxiliary Storage

5. ______Communication Devices

a. 
Make information resulting from processing available for use.

b. Allows data, programs, and user responses to be entered into a computer

c. Hardware component that enables a computer to send and receive data, instructions, and information to and from one or more computers.
d. Contain circuits that cause processing to occur

e. Allows storage of data in an electronic form

6. _________Which piece of hardware is not an input device?

a. Keyboard

b. Printer

c. Scanner

d. Microphone

7. ________Which piece of hardware is part of the processing?

a. Keyboard

b. Control Unit

c. Arithmetic/logic Unit

d. Mouse

e. b & c

8. T/F______RAM memory is referred to as Main Memory and anything stored in RAM will be lost when the power is turned off.

9. Number the following units of memory in the proper order from smallest to largest:

a. ______ gigabyte

b. ______Kilobyte

c. ______ Terabyte

d. ______ Megabyte

10. A memory location holds

a. 1 byte

b. 1 character

c. 1 word

d. A & B
11. ________ In order for a computer to work, the operating system software must be stored

a. In the computer’s main memory

b. On a floppy disk

c. On the C: drive

d. On the network

12. _______  Printers are output devices. Which printer is similar to a copy machine?

a. Ink jet printer

b. Laser printer

c. Impact printers

13. ________ What is true of an LCD monitor

a. Uses liquid display crystal similar to a digital watch

b. Referred to as a flat panel

c. More expensive

d. Composed of pixels

e. All of the above
14. Put the following storage devices in order of capacity. Put 1 for the largest down to 6 for the smallest.

a. _____ Zip disk

b. _____ Floppy Disk

c. _____CD-ROM

d. ______Flash Memory card

e. _____ Hard  Drive

f. _____DVD

15. ________Which auxiliary storage medium can be written on multiple times

a. CD-ROM (compact disc read-only memory)

b. CD-R (compact disc-recordable)

c. CD-RW (compact disc-rewritable)

d. DVD-ROM (digital video disc-ROM) 
16. ________ A flash memory card (jump drive) is connected to the computer by a
a. DVD drive
b. parallel port
c. USB port
d. wireless connection
e. Zip Drive

17. _______Software can be categorized into two types:

a. Word processing and spreadsheet software

b. Web page design and desktop publishing software

c. Communication and database software

d. Operating system and application software

18. _____ T/F Operating system is not essential. The computer can operate properly without this type of software. 

19. ________A GUI (Graphical User Interface) refers to:

a. The way the user interfaces with the computer hardware

b. Provides visual clues to help the user interface with the computer.

c. The way the user identifies the hardware resources on the computer

d. The way the user gets on the Internet

20. _________A GUI is a user interface. How does it communicate with the user?

a. Commands

b. Text

c. Graphics

d. Text and graphics

21. _______Which of the following application software is not a common application software

a. Microsoft Word

b. Microsoft Excel

c. Microsoft XP

d. Microsoft PowerPoint

Matching

22. _______ Word Processing

23. _______Spreadsheet

24. _______ Database

25. _______ PowerPoint

a. 
creates slide shows used for presenting information

b. allows user to add, subtract and perform other calculations using a row and column structure

c. allows user to create business documents

d. allows for easy retrieval, organizing of large amounts of data. 

Match the term with its definition

25. _______ WAN

26. _______ LAN

27. _______ Star Network

28. _______ ISP

29. _______ domain

a. 
A service that provides a user with access to the Internet for a monthly fee

b. The part of the URL or address that identifies the type of website

c. A network that covers a large geographical area

d. A network configuration where computers are attached to separate lines all of which lead to the same central station

e. A network that covers a relatively small geographical area.

30. ______ Browser

31. ______ Virus

32. ______ Website

33. ______ HTTP

34. ______ Internet

35. ______ URL




a. A program that infect a computer causing damage or mischief.

b. A computer connected to the Internet containing web pages you can reference
c. The unique address for every web page

d. The first part of the URL that indicates the protocol for transferring pages on the web. 

e. A collection of networks that link together millions of computers through modems

f. Software that allows a user to surf the internet

36. Identify each part of a URL:  http://www.windowsmarketplace.com/category.aspx?bCatID=282
A
B



C
D

__________ domain

__________ protocol

__________ path

__________ web page name
37. _________T/F A good question to ask yourself when buying a computer is: “What do I want to do with my computer? What are my needs?

38. _________  T/F A good rule of thumb when buying a computer is to buy the least expensive one available.

39. _______What would be considered poor logic when buying a computer

a. Buy a computer that will meet your future needs for 2-3 years

b. Stick with brand names

c. All operating systems can run all software so don’t worry about matching them

d. Consider more than price. Compare what is included in the computer package.

40. ________ For most users purchasing a notebook, an(n) ________ display is satisfactory.

a. 8.3 inch

b. 14.1 inch

c. 16.1 inch

d. 20 inches

41. ________The resolution of a notebook computer should at least be

a. 1024 x 768

b. 860 x 600

c. 1400 x 850

d. 1550 x 1000

42. _______When the computer is frozen what combination of keys will allow you to shutdown the computer?

a. Ctrl+End

b. Alt+Ctrl

c. Ctrl+Alt+Delete

d. Alt+Shift+Delete

43. _______The Start button lets you do all EXCEPT

e. Search for files and folders

f. Launch programs

g. Connect to the internet

h. Publish files to the Web
44. _______Items in the Recycle Bin 

i. Are deleted when the power turns off

j. Are file that have been deleted from the H: drive

k. Can be recovered by clicking Restore

l. Are gone forever

45. ________Which of the following is NOT part of the Accessories options?

m. System Tools

n. Notepad

o. Paint

p. WordPad

q. Start button

46. ________ When you right-click on an object, what displays?

r. A dialog box

s. A drop down menu

t. A shortcut menu

u. An active menu
47.  Which view displays the most pictures at the same time? ______________

48. _______Which is not a task you can do with a file in Windows Explorer

v. Delete

w. Copy

x. Move

y. Rename

z. Publish

49. _______Looking at folders in the Folder View of My Computer, the + sign indicates

aa. The folder can be expanded

ab. The folder has other folders within it

ac. The folder has other files within it

ad. A and B

50. _______To select two or more adjacent files or contiguous files you select the first file then

ae. Shift Click the last file

af. Ctrl Click the last file

ag. Alt click the last file

ah. Ctrl+Shift click the last file

51. _______To select two or more non adjacent files select the first file then hold down the _____ key to select any other files.

ai. Tab

aj. Shift

ak. Ctrl

al. Windows

52. ______ T/F The copy file command will make a duplicate of the original file and the original file will no longer be where it was.

53. ______ T/F If you drag a file from one folder to another folder on the same drive, Windows XP moves the file, but if you drag a file from one folder to a folder on a different drive, Windows XP copies the file.

Match the word with its definition:
54. ______ Multitasking

55. ______ Active Window

56. ______ Scroll Bar

57. ______ Shortcut Menu

58. ______ ToolTip



am. The box of explanatory text that appears when the mouse passes over a command button or icon

an. Appears along the bottom of a window indicating there is more information that cannot be seen

ao. Distinguished by the dark blue bar along the top of the window

ap. The ability to have several documents or programs open at the same time

aq. A menu of choices that appears when user clicks the right mouse button

62.
_________What is true of a filename

a. Programs seldom use file extension such as .docx
b. Long filenames can contain spaces

c. Long filenames cannot contain spaces

d. Filenames can contain special characters such as / \ < > ? *

59. Path to create a folder is _____________________________________________

60. The path to delete a folder ___________________________________________

61. The path to rename a folder __________________________________________

62. What is the root of your H: drive ______________________________________

63. The steps to take a screen shot:
a. Press the ________________________________ on your keyboard

b. Open word, select __________________________from the Home Tab Ribbon

Organizing H: Drive Assignment

1. Create the following folders on the root of your H: Drive plus three other folder of classes you are currently enrolled in:

Your Last Name Adv Comp Tech
PE

English








2. In your Adv Comp Tech folder create the following subfolders:

Word



Bell Quizzes
Excel



PowerPoint
Access
Database

TBE 1700


3. Delete the PE folder on your H: drive

4. Rename your English folder to the name of your English class 
5. Rename your Bell Quizzes Folder to be Quizzes
6. Click on your H: drive. Expand all folders in your root drive. Take a screen shot of the root of your H: drive. Put your name on the document. Print the screen shot and attached to your listening guide.

a. Save screen shot as H drive screen shot #1 in your TBE 1700 folder

7. Copy the class disclosure file into your TBE 1700 Folder. The disclosure is located in: X:\apps\company\bus_classes\adv comp tech
8. Move any other files you may have into the proper folder. There should be no files in the H: root.

9. Click on the H: drive. Expand all folders. Take a screen shot. 
a. Paste screen shot into a Word document. 
b. Put your name on the document. 
c. Save the document as Screenshot.docx. 
d. Print the screen shot and attached to your listening guide.
10. Save the file as Screenshot.docx inside the TBE1700 folder.
11.
Email your instructor a message from your school email
12.
Subject Line: TBE1700
13.
Put your email address in the CC box so you will get a copy of the email.
14.
In the message include the following:

· Your name 

· Why you are taking this course? 

· In a separate paragraph, tell five unique things about yourself
· Attach the Screenshot.docx file 
· Send the email
15. 
Print the copy of the email that you receive and attach to the Windows Module.
Computer Comparison Worksheet         


For this assignment you will comparison shop for a desktop computer, a laptop computer, a tablet, or a PDA. Make some decisions about how you will use the computer, then find two models that meet your requirements, and list the models, their respective prices, and the sites where you found them. 

You may go to a store or you may “window shop” online. Figures 38 on page COM-26  lists several computer sales companies.  Pages COM24-COM38 of your textbook guide you through the computer purchasing process. Refer to these pages to complete this worksheet.

Figure 40 on pages COM27-COM28 provide explanation on the components listed below. Use specific details for each answer to receive full credit.  Attach your answered sheet to the Windows Module

	1. I am comparison shopping for a desktop computer, a laptop computer, a tablet, a PDA.  List 

your choice

	2. List each application software program you plan on using. 

What will you use each software application for?  

What does each software program you plan on using cost?

	3. Extras:  Are you going to buy a digital camera or a music player? Why or Why not? 

If yes, what is the cost of each unit?



	4. Storage: What size hard drive will you include in your purchase? Why?

	5. Storage: Will you purchase an external hard disk?  

What is the purpose of an external hard disk?  



	6. Input:  How many USB ports will you need?

	7. Input:  Will you purchase a joystick/wheel/keyboard/microphone/mouse? 
Will you purchase a wireless mouse?  A wireless keyboard?

Which will you purchase?  What is the cost?

	8. Communication:  What kind of Internet service will you use?  Justify your choice.

 What is the cost of that internet service? (Look it up on the Web)



	9. Output:  What kind of monitor do you want?  What size?

	10. Output:  What kind of printer fits your needs?  Give printer specifications and cost.

	11. What type of processor do you need? What speed? (Check page COM 29 before answering)

	12. How much RAM will you require? (If you are purchasing Windows Vista, read through the chart on page COM26 before answering this one.)



	13. Extras:  Will you purchase a scanner?  What brand?  What is the cost?

	14. Extras:  Will you purchase a PC video camera?  If so, what are the specifications and cost?

	      14.  What is the make and model of the two computers you have decided to purchase:  List the Web site URL for each of the computers.

#1)                                                                                                                                 Price:

#2)                                                                                                                                 Price:



	15.  Does bundled software come with the computer? What bundled software will be useful to you?

Computer #1:

      Computer #2:




Windows Vista Options

On the Internet there is a set of files about Windows Vista.  Go to the URL below:

http://www.weber.edu/video/play_single.html?videoTitle=Windows%20Vista&fmsInst=jporter&fmsFile=vista_video01.flv 

There are 4 of them, video01, video02, video03, video04, the rest of the link is the same.

View the first four movies tours.  They are very informative, yet very short. OR  If you have access to Windows Vista, you can answer the following by using the Help option of Windows Vista. Answer the following questions about Windows Vista.

1) The Side Bar holds gadgets.  What are gadgets?  How are new gadgets added to the Side Bar?

2) How is the Snipping Tool used?  Once the Snipping Tool has been used, in which format is the image saved?

3) With Windows Flip, what does ALT+Tab do?  

4) Windows Vista Voice Recognition offers fully integrated support for what three items? 

5)  What is Aero Glass?

Activity #1: Explore Windows XP My Computer 





Click on Start. Notice the choices.


Click on Programs > Accessories. Notice the choices


Open My Computer using the shortcut keyboard method: (Windows key) + E





Double click the icon in the right panel for your H: drive to display the folders 


Double click the folder for your class. Notice the choices in the section Files and Folder Tasks on the left. The most common task is Make a new Folder. Now click a file. Notice the choices on the left side in the section Files and Folder Tasks. Choices are rename, copy, move, delete, email. (Not enabled at Layton High)





The View Menu also lets you view the resources as Filmstrip, Thumbnails, as icons, as Tiles, as a List, and as Details. 





Navigate to C:\Windows\Web\Wallpaper. View the folder as Filmstrip, Thumbnails, Tiles, Icons, List, Details. Which view displayed the most pictures at the same time? Write your answer on the line of question #47





To change the look of the My Computer window click View>Explorer Bar>Folders. This view displays a list of Drives and folders available on the left side in list form and similar items in icon form on the right side. Let's discuss some features:





Notice the plus + or minus - icon in front of the drive names. The + sign indicates there are more folders inside the drive or folder. A minus sign in front indicates the folder is collapsed, in other words all folders in that folder are being displayed.





Click on the - sign in front of My Computer to collapse the folder





Click on the +sign to expand C:\ drive 





Expand the Windows folder in C:\.





Expand the Security folder in C:\Windows





Retrace your steps and close the Security folder, the Windows folder, and the C:\ Drive.


Toolbar icons: Use these to help you navigate





Click the BACK button to take you to the previously displayed window.





Click the yellow folder with the green up arrow to go up one level.
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